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Step 6: Reviewing Design Run Settings 

One of the main differences between the Non-Project Mode you used in Lab #1, and the Project 

Mode which you are now using, is the support of design runs for synthesis and implementation. 

Non-Project Mode does not support design runs.  

Design runs are a way of configuring and storing the many options available in the different 

steps of the  synthesis and implementation process. You can configure these options and save 

the configurations as strategies to be used in future runs. You can also define Tcl.pre and 

Tcl.post scripts to run before and after each step of the process, to generate reports before and 

after the design progresses.  

Before launching the synthesis and implementation runs you will review the settings and 

strategies for these runs.  

1. In the Flow Navigator, select Synthesis Settings under Synthesis. 

The Project Settings dialog box opens. The Synthesis Settings provides you access to the 

many options available for configuring Vivado synthesis. For a complete description of 

these options, see the Vivado Design Suite User Guide: Synthesis (UG901).  

 

Figure 22: Synthesis Settings 



 Step 6: Reviewing Design Run Settings 

Design Flows Overview   34 

UG888 (v2013.1) March 20, 2013 

2. After reviewing the various synthesis options, select the Implementation button on the 

left side of the Project Settings dialog box, as shown in Figure 22. 

The Project Settings change to reflect the Implementation settings. You will not modify 

the Implementation options in this lab. , you can view the available options for 

Implementation runs. For a complete description of these options, see the Vivado Design 

Suite User Guide: Implementation (UG904). 

 

Figure 23: Implementation Settings 

3. Click Cancel to close the Project Settings dialog box. 

You are now ready to launch Vivado synthesis and implementation. 

  

http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.1;d=ug904-vivado-implementation.pdf
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Step 7: Synthesizing and Implementing the Design 

After configuring the synthesis and implementation run options, you can: 

 Use the Run Synthesis command to run only synthesis. 

 Use the Run Implementation command, which will first run synthesis if it has not been run, 

then run implementation. 

 Use the Generate Bitstream command, which will first run synthesis and then run 

implementation if they have not been run, then write the bitstream for programming the 

Xilinx device. 

For this tutorial, we will run these steps one at a time.  

1. In the Flow Navigator, click on the Run Synthesis button, and wait for this task to 

complete.  

Notice the progress bar in the upper-right corner of the Vivado IDE, indicating the run is 

in-progress. Vivado launches the synthesis engine in a background process to free up 

the tool for other actions. While the synthesis process is running in the background, you 

can continue browsing Vivado IDE windows, run reports, further evaluate the design. You 

will notice that the Log window displays the synthesis log at the bottom of the IDE. This 

is also available through the Reports window. 

After synthesis has completed, the Synthesis Completed dialog box prompts you to 

choose the next step.  

 

Figure 24: Synthesis Complete 

2. Select Run Implementation, and click OK. 

The implementation process is launched, and placed into a background process after 

some initialization. The next step in this tutorial shows you how you can perform design 

analysis of the synthesized design, while you wait for implementation to complete. 
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Step 8: Analyzing the Synthesized Design 

Opening the synthesized design enables design analysis, timing constraint definition, I/O 

planning, floorplanning and debug core insertion. These features are covered in other tutorials, 

but you can take a quick look in this step. 

1. Select Open Synthesized Design in the Flow Navigator and wait for the design to load. 

Notice that as the Vivado IDE opens the synthesized design, the implementation continues 

running in the background. At some point while you are exploring the synthesized design, 

implementation will complete, and the Implementation Completed dialog box prompts you 

to choose the next step.  

 

Figure 25: Implementation Complete 

2. Click Cancel to close the dialog without taking any action.  

This leaves the synthesized design open. You will open the implemented design after 

you are finished examining the features of the synthesized design. 

3. Ensure that the Layout Selector pull down menu in the main Toolbar has Default Layout 

selected. 

4. Click the Reports window tab at the bottom of the Vivado IDE.  

If the Reports window is not open, you can open it with Windows > Reports. 

5. Double click the Vivado Synthesis Report to examine the report. 

6. Double click the Utilization Report to examine the report.  

7. Close all reports when you have finished examining them. 

8. Click the Messages window tab at the bottom of the Vivado IDE.  

If the Messages window is not open, you can open it with Windows > Messages. 

The Messages window provides message type filters in its banner, to display or hide 

different types of messages: Errors, Critical Warnings, Warnings, Info, and Status. 
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9. Click the Collapse All button to condense all of the Messages.  

10. Expand the Synthesis messages.  

11. Scroll through the Synthesis messages and notice the links to specific lines within source 

files. Click some of the links and notice the source file opens in the Text Editor with the 

appropriate line highlighted.  

 

Figure 26: Synthesis Messages Linked to Source Files 

12. In the Flow Navigator, under Synthesized Design, select Report Timing Summary. 

The Report Timing Summary dialog box opens. Examine the various fields and options of 

this command.  

13. Click OK to run with default options. 

The Timing Summary Results window opens.  
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Figure 27: Report Timing Summary 

Examine the Timing Summary Results window showing timing estimates prior to 

implementation. Click on some of the reporting categories in the tree on the left side of 

the Timing Summary Results window. 

14. Select Report Power in the Flow Navigator. 

The Report Power dialog box opens. Examine the various fields and options of this 

command.  

15. Click Run to run with default options. 

The Power Results window opens. Examine the Power Results window showing power 

estimates prior to implementation. The report is dynamic, with tooltips providing details 

of the specific sections of the report when you move the mouse over the report, as 

shown in Figure 28.  

Click on some of the reporting categories in the tree on the left side of the Power Results 

window to examine the different information presented. 

 

Figure 28: Report Power 
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16. Close the Report Timing Summary window, the Power Report window, and any open 

Text Editor windows. 

Step 9: Analyzing the Implemented Design 

The Vivado IDE is interactive, enabling editing of design constraints and netlists on the in-

memory design. When you save the design, constraint changes are written back to the original 

source XDC files. Alternatively, you can save the changes to a new constraints file to preserve the 

original constraints. This flexibility supports exploration of alternate timing and physical 

constraints, including floorplanning, while keeping the original source files intact. 

Opening the Implemented Design  

1. Select Open Implemented Design in the Flow Navigator.  

2. Select Yes to close the synthesized design and Don’t Save, if prompted. 

After the Implemented Design has loaded, you can see the implementation results in the 

Device window. 

3. Click on the Reports window tab at the bottom of the Vivado IDE. 

If the Reports window is not open, you can open it with Windows > Reports. Select and 

examine some of the reports from Place Design and Route Design. Close each of the 

reports when you are done. 

4. Select the Messages window tab at the bottom of the IDE. 

If the Reports window is not open, you can open it with Windows > Messages. 

5. Click the Collapse All button to condense all of the Messages.  

6. Expand the Implementation folder  

View the messages from Design Initialization, Opt_Design, Place_Design, and 

Route_Design. 
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Analyzing Routing 

After the design has been placed and routed, you can generate a timing report to verify that all 

the timing constraints are met. You can select paths from the Timing Report window to examine 

the routed path in the Device window. If there are timing problems, you can revisit the RTL 

source files or design constraints to address any problems.  

7. In the Device window, select the Routing Resources button to display the device 

routing. 

This lets you see the routed connection in the Device window. Though you will need to 

zoom closely into the device to see elements of the route, a zoomed-out view lets you 

see the route in its entirety.  

 

Figure 29: Routing Resources Button 

8. Select the Auto Fit Selection button in the Device window toolbar menu to enable the 

Vivado IDE to automatically zoom into and center the selected objects. 

9. In the Flow Navigator, under Implemented Design, click on the Report Timing 

Summary button. 

10. Click OK in the Report Summary Timing dialog to generate the default report. 

11. On the left side pane of the Timing Summary Results window, select: 

Intra-Clock Paths > bftClk > SETUP… 

In the table view on the right side of the Timing Summary Report window, click on any 

timing path to select it and highlight it in the Device window. Select various paths in the 

Timing Summary window and examine the path routing.  

12. On the left side pane of the Timing Summary Results window, select: 

Intra-Clock Paths > bftClk > HOLD… 

Click on any path in the table view on the right side of the Timing Summary Results 

window to select it and highlight it in the Device window. Select various paths in the 

Timing Summary Results window and examine the path routing. 
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Figure 30: Examine Routing for Timing Paths 

13. With a timing path selected, right-click to open the popup menu in either the Device 

view or the Timing Summary window, and select the Schematic command  

Note: Alternatively, you can press the F4 function key to open the Schematic window. 

The Schematic window opens, displaying the schematic for the selected timing path. Use 

commands from the popup menu in the Schematic window, such as Expand or Collapse 

Outside, or Expand Cone, to traverse the schematic and examine the logic cells on the 

timing path.  

14. Close the Schematic window. 

15. In the Device window, select the Routing Resources toolbar icon again to turn off 

routing resources. 

The Device window now displays just the placed instances, without the added details of 

the routed connections. 
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Step 11: Generating a Bitstream file  

Since the XDC constraints file has LOC and IOSTANDARDs constraints set for all of the I/O ports, 

you can generate a bitstream. Before launching Write Bitstream, you will review the settings for 

this command.  

1. In the Flow Navigator, select Bitstream Settings under Program and Debug. 

The Project Settings dialog box opens. The Bitstream Settings provides you access to the 

options available for the write_bitstream command. For a complete description of these 

options and how to use them, see the Vivado Design Suite User Guide: Programming and 

Debugging (UG908).  

 

Figure 31: Bitstream Settings 

2. Click Cancel to close the Project Settings dialog box. 

3. In the Flow Navigator, under the Program and Debug section, click on the Generate 

Bitstream button. 

4. After the bitstream has been generated, click OK in the Bitstream Generation Completed 

dialog box to view the reports from the command. 

http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.1;d=ug908-vivado-programming-debugging.pdf
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Step 12: Exiting Vivado  

Vivado creates two files as it runs:  

 The Vivado tools log (vivado.log) file contains the history and results of all Tcl 

commands executed during the Vivado session.  

 The Vivado tools journal (vivado.jou) file contains only the Tcl commands executed 

during the Vivado session, without the added details recorded in the log file.  

These files are a great way to learn the Tcl commands used by the Vivado tools to perform 

different design tasks. The Vivado journal is also a great source of help when creating a new Tcl 

script. Using the vivado.jou file from a completed design flow, you can see all of the Tcl 

commands needed to complete the design. Refer to the Vivado Design Suite Tcl Command 

Reference Guide (UG835) for a complete description of the Tcl commands and their options. 

1. Select File > Exit, or type exit in the Tcl command line. 

2. Click OK to close the Vivado tool. 

3. Examine the Vivado log (vivado.log) file. On Windows, it may be easier to use the file 

browser. 

<Extract_Dir>/Vivado_Tutorial/vivado.log 

Note: This is the location you entered for the Start-in property in Step 1 of Lab #2. 

4. Examine the contents and close the file. 

Step 13: Creating a Tcl Script from the Journal File 

Running in batch mode is faster and takes less memory than running in the Vivado IDE. When 

you need multiple runs to complete a design, it is a good idea to use a Tcl script to automate 

the flow. You can also add report generation commands into the script after key steps, and 

redirect the output to specific files and directories. 

Examining the Journal 

In this step you manually create a Tcl script from the journal file that the Vivado tools 

automatically created as you worked from Step 1 through Step 12 of this lab. When you execute 

the new script, it will create a project file (.xpr) and directory structure just as you did when you 

worked through these steps using the Vivado IDE. If you load this project into the Vivado IDE, 

you will see all the results and project status displayed, as you would expect. 

1. Open up vivado.jou file in a text editor.  

2. Examine the Vivado journal (vivado.jou) file. On Windows, it may be easier to use the 

file browser. 

http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.1;d=ug835-vivado-tcl-commands.pdf
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<Extract_Dir>/Vivado_Tutorial/vivado.jou 

You should see something similar to what is shown below. 

 

Figure 32: Vivado Journal for Lab #2 

Note: If you are using Linux, you will see different path references. 

3. Remove the comment header as unnecessary (text lines starting with #).  

4. Since you do not want to open the IDE in the Tcl script, remove the start_gui line. 

5. Use the Save As command to save the file to 

<Extract_Dir>/Vivado_Tutorial/run_bft.tcl.  

6. With the run_bft.tcl script opened, search and replace all occurrences of “project_bft” 

with “project_bft_batch”. 

7. Examine the script and notice the differences in this Project Mode script from the Non-

Project mode script used in Lab #1 of this Tutorial.  

You should take note of the add_files and set_property commands used for 

project creation, as well as the commands to set up the constraints sets.  

You should also notice that launch_runs is used instead of synth_design, etc. Use 

the launch_runs command when creating or running Project based designs.  

 

CAUTION! Mixing the individual commands (synth_design, opt_design …) with 

launch_runs could damage the Project, and is not recommended. The launch_runs 

command has Tcl options to run steps independently, and create intermediate reports. See the 

Vivado Design Suite Tcl Command Reference Guide (UG835) for more information.  

http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.1;d=ug835-vivado-tcl-commands.pdf
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Editing the Batch Project ScriptIf you did not complete Lab #2 of the tutorial in one design 

session, your vivado.jou file will not reflect the complete design flow from step 1 through 

step 12. In this case, you can use the run_bft_project.tcl script which can be found in the 

Vivado_Tutorial directory.  

Lines 1 through 9 of the run_bft.tcl script create the design project and specify the target 

Xilinx part; add the source RTL and XDC files; and define the VHDL library. The script creates 

synthesis and implementation runs, synth_1 and impl_1, and defines the constraint set, 

constrs_1.  

The next few lines elaborate the RTL design and simulate it. You don’t need to do that in the 

batch flow. 

1. Remove the following lines from your script by deleting the lines, or inserting the ‘#’ 

symbol to make the lines comments in the Tcl script: 

#synth_design –rtl –name rtl_1 

#close_design 

#launch_xsim -simset sim_1 -mode behavioral 

#close_sim 

In the previous steps in this tutorial, you ran synthesis and implementation, and analyzed 

the synthesized design while implementation was running. In the batch flow, you will run 

synthesis, then run the timing and power reports, and then run implementation. You 

need to reorder the Tcl commands in the scrip to accomplish this. Cut the open_run 

command, and the next three lines and move them up to follow the wait_on_run 

command. 

2. Cut the following lines: 

open_run synth_1… 

set_delay_model… 

report_timing_summary… 

report_power… 

3. Paste them after the wait_on_run synth_1… line. 

Now the script launches synthesis, waits for synthesis to complete. Then launches 

implementation and waits for implementation to complete. Finally, the script should 

launch write_bitstream and wait for it to complete.  

4. Remove the close_design line if one is in the file. 

5. Your file should now look like the following: 
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Figure 33: Edited Tcl Script 

Running the Batch Project Script 

You can now execute your new TCL script, running Vivado tools in batch mode, which will run all 

the commands in your Tcl script and then quit Vivado when finished.  

1. On Windows, open a Command Prompt window. On Linux, simply skip ahead to step 3.  

2. Change directory to the Xilinx installation area, and run the settings32.bat or 

settings64.bat as needed to setup the Xilinx tool paths for your computer: 

cd <Vivado_install_area>/Vivado/2013.1 

settings64 

The settings64.bat file configures the path and environment on your computer to run the 

Vivado tools.  

3. Change directory to <Extract_Dir>/Vivado_Tutorial, and launch the Vivado tool in 

batch mode: 

cd <Extract_Dir>/Vivado_Tutorial 

vivado -mode batch -source run_bft.tcl  

4. Examine the Vivado log output, as it is transcripted to the Command Prompt window. 

Since the launch_runs command is used, less information is echoed to the tool 

transcript. Reports and run status are also gathered in the Project and will be available 

after the run completes. 

Because you ran the Vivado tool in batch mode, it exits after the sourced script has 

completed running.  

5. Review the new vivado.jou file which is the result of running this batch script. The 

journal file should look like the run_bft.tcl script that created it.  
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Step 14: Checking the Design Status 

1. Launch Vivado IDE and open the BFT batch project (project_bft_batch.xpr) that 

you just created: 

Start > All Programs > Xilinx Design Tools > Vivado 2013.1 > Vivado 2013.12 

As an alternative, you can launch the Vivado IDE from the command line: 

> cd <Extract_Dir>/Vivado_Tutorial/Tutorial_Created_Data 

> vivado –mode gui 

The Vivado IDE will launch. 

2. Open the project with File > Open Project, and locate project_bft_batch. 

As you can see in the project status bar in the upper right of the Vivado IDE, the status 

reflects the fact that a bitstream has been generated (write_bitstream Complete).  

3. View the implemented design by clicking the Open Implemented Design button in the 

Flow Navigator.  

4. Quit the Vivado tool when you are finished. This concludes the tutorial. 

File > Exit 

Summary 

After completing this tutorial, you should have learned the following: 

 The use of Project Mode and Non-Project Mode. 

 Creating an RTL project in the Vivado IDE. 

 Configuring the Vivado synthesis, simulation and implementation tools. 

 Launching the Vivado simulator, synthesis and implementation. 

 Applying constraints to the synthesized design. 

 Generating timing and power reports. 

 Examining routing results in the Device editor. 

 Generating a bitstream file. 

 Using a Journal file (.jou) to create a project based Tcl script. 

 Launching a project based Tcl script from the command line. 

 Switching between the Vivado Design Suite Tcl shell and the Vivado IDE. 

                                                 

2 Your Vivado Design Suite installation may called something different than Xilinx Design Tools 

on the Start menu.  


